
Welcome to the HHELP Help System
If you are a new user and would like a tutorial on how the Help System works, 
move your mouse until the cursor is over the word TUTORIAL (coloured dark blue
below). Then press the left mouse button.

TUTORIAL

TIP: For Microsoft Windows users, the HHELP Help System is very similar to 
Windows Help.

Reference Information:

How to:
Start and stop the Help System 
Manipulate Help System windows
Move around the Help File 
Use the Help System with programs and data files

Menu Commands: 
File 
Bookmark
Help
Capture window menu 

Buttons:
Contents
Search
Browse Buttons

Notes:
On graphics
On available help files
Help System Colours 



HHELP Help System Tutorial
Congratulations. You have learned the basic step of the Help System - jumping 
from topic to topic. Any text coloured dark blue is a jump. Move the cursor 
over it and press the left mouse button, and you will jump to a new help topic
related to that text.

Topics are the main unit of a help file. Each one contains information about a
different aspect of the program or application that the help file is 
associated with. The name of a help topic always appears at the top of the 
text and is coloured white.

Try another jump, by moving the cursor over Help System Colours below and 
pressing the left mouse button:

Help System Colours 



Pop-Ups and Graphics
The other main tool of help systems is the pop-up. Pop-ups are similar to 
jumps but only bring up temporary information, often definitions or reminders.
All pop-ups are coloured yellow. Select the pop-up below for more. (Remember, 
to select, move the mouse until the cursor is on what you want to select, then
press the left mouse button.)

POPUP 

Some help files can reference graphics files by calling them up to view in the
specified graphics viewer program. To try this, select the magenta-on-black 
text below.

$IMAGE.
In order for the graphic to display, you must define a viewer program in the 
[Viewer] section of the HHELP.INI file. The viewer program you supply will 
display those images in the help file defined with a $ in the first position. 
The $ will be ignored, and the image will be searched for as IMAGE.* in the 
path given in the [GraphicPath] section of HHELP.INI.

To learn more, select to jump to All These Windows



Help System Colours
All jumps in the Help System are dark blue. Other colours represent different 
things:

Black is used for regular text
White is used for topic headings
Yellow is used for POP-UP hotspots (more on those later)
Dark Yellow is used to keys the user types in
Dark Magenta is used for headings and highlights
Dark Red is used for notes and warnings
Dark Green is not used much.
Magenta text on a black background indicates a graphic that can be seen with 
the graphic viewer you specify in the [Viewer] section of the HHELP.INI file. 
(This is a non-working example. Working samples will appear later.)

To continue the tutorial, move the cursor over Mouse and Key commands below 
and press the left mouse button:

Mouse and Key Commands



Very Good
Yes, this one really IS a pop-up. You must be an inquisitive user. Hit any key
or click with the mouse to make this message go away.



Mouse and Key Commands
Note: some help topics are too long to appear completely in the window. More 
text can be viewed by moving the mouse cursor over the blue bar and  the up 
and down arrow characters (this is the scroll bar) near the right window 
border and pressing the left mouse button.

For the rest of the tutorial, follow these instructions:

All key combinations for you to press are indicated in dark yellow.

Special case examples:

ALT+G A plus means hold down the first key and hit the second.
ALT,H,A Commas between key presses indicate to press and release the keys 

in order.

These instructions apply to the mouse:

Point:
Position the mouse pointer/cursor over the indicated item

Click:
Press and release the LEFT mouse button

Select:
Point and then click on an item. Sometimes called clicking on an item.

Double-select:
Point to the indicated item and click twice. Sometimes called double clicking 
on an item.

Drag: 
Point to an item and then hold down the mouse button while moving the mouse

Any instructions requiring the RIGHT mouse button will be explicitly stated.

Remember, to quit the tutorial type ALT+X

From here we move to Pop-ups and Graphics



Welcome to the Pop-up
Pop-ups pop up in temporary windows like this to provide brief reference 
information. Temporary pop-up windows can also contain jumps and further pop-
ups, each of which, when selected, make the original pop-up window disappear. 
To close a pop-up, hit any key, or click the mouse.



All These Windows
The next thing to know about using the help system is windows.

When the help system becomes active, the current screen is captured - a 
picture of it is taken, and it is put in a window similar to the one this help
file is in, called the capture window. The help file window appears on top of 
this captured screen window. These windows are very similar to Microsoft 
Windows windows.

While the help system is operating, you can not use your application, although
you may be able to see some text on the screen behind the capture window and 
the help window. It is easy to be tricked into thinking your program is still 
operating, because the captured screen in the window looks exactly like your 
application screen - but it is not. The capture window is a context sensitive 
help screen, which you will learn about soon.

For now, use these pop-ups for information on windows:

Changing the size of a window
Moving a window
Scrolling through windows 
Switching between windows
Closing A Window

Try each of these tasks after reading the information. Remember - to close a 
pop-up, hit any key, or click the mouse.

When finished with windows, move on to Context Sensitivity



Closing a Window
To close the active window (the one you clicked in most recently), select the 
square dot in the upper left border of the window. Closing all help file 
windows quits the help system. Typing ALT+X also quits. Note once the capture 
window or the help window is closed, there is no way to open it again without 
leaving the help system. If just one of them is closed, the help system will 
continue to operate, but you will not be able to jump from one to the other 
using context sensitive help features (explained later on).



Moving a window
To move a window around the screen, move the cursor to the top border of a 
window. The border is the white, double-lined part. Do a drag operation (press
and hold the button, then move the mouse) to move the window.



Changing the size of a window
There are two ways. The first is to drag the left, right or bottom of the 
window (the double-lined white part only). Remember dragging is pressing and 
holding the mouse button, then moving the mouse. To resize the horizontal and 
vertical size at the same time, grab a corner and drag it.

The second is to use the up-arrow and down-arrow characters on the upper right
border of any window. Selecting the up-arrow maximizes the window to fill the 
screen. Selecting the down-arrow minimizes the window to a small box in the 
lower left-hand corner.

After maximizing or minimizing, the two arrows become one dot. Selecting the 
dot will return the window to the previous size.



Switching between windows
Only one window can be active at a time. The active window is always the one 
in front, and is the one you clicked in most recently. Non-active windows will
not respond to commands. To switch to another window, select it. (Move the 
cursor to it with the mouse and click). If the window you want is completely 
hidden behind the active window, the active window will have to be moved or 
resized to reveal the window you want.

See Changing the size of a window 

To cycle through all the available windows, use ALT+ESC or the F2 key.



Scrolling
Sometimes all the information in a file does not fit into the window. More 
information can be seen by selecting the up, down, left and right arrow 
characters separated by a blue bar. This is the scroll bar and the scroll 
arrows. These items will scroll the text in the window up, down, left or 
right, revealing more information. If there is no scroll bar, then there is no
more information in this topic - it is all in the window.

The PAGE-UP and PAGE-DOWN keys will move a screen at a time.



Context Sensitivity
If a topic is very long, to see it all, remember to scroll by selecting the 
arrows on the window border. To print the topic out for future reference, type
ALT+F,P. This is the print topic command under the file menu, which may also 
be reached with the mouse by selecting the File menu (where it says File in 
the window) and then the print option, which will appear beneath the File menu
when it is selected.

The HHELP Help System uses the capture window to provide context sensitive 
help. Context sensitive means precision help is available depending on what 
you are doing at the time.

Choose How Context Sensitivity Works



How Context Sensitivity Works
Here is how it works: When you activate the window containing the captured 
screen, and move the cursor across the text, certain text is highlighted in 
cyan (light blue). Highlighting means the text is referenced in the help file.
If text is highlighted, pressing the LEFT mouse button will automatically 
activate the help window and display the first topic with information about 
the highlighted text. Pressing the RIGHT mouse button will bring up an index 
window with information about the selected text.

Continue with The Index Window



The Index Window
The index window is the same window activated by selecting the search button 
in the help window. It has a list of keywords that you can scroll through by 
selecting the scroll arrows or scroll bar. There is also a box for entering 
keywords you wish to search for. The BACKSPACE key removes characters from 
this box. When you see the desired keyword in the list, select it. You will be
presented with a list of topics in the bottom part of the window. Choose among
the list of help topics that is displayed below by selecting one. This 
activates the help window, with the topic you have selected in the window.

Using the captured screen for context sensitive help is the quickest and most 
accurate way to find information in a help file. Nearly any commands on the 
screen of a program that has a help file will be referenced, and from there it
is a direct jump to information about that command.

Continue with More on Context Sensitivity

Remember ALT+X quits the help system.



More on Context Sensitivity
Context sensitive help can also be used with data files. If there is a path 
and filename in the capture window (for example C:\DOS\MYFILE), moving the 
cursor over it will highlight it in magenta (light purple) and pressing the 
RIGHT mouse button will load that file into a new window. You can move the 
cursor through this file to highlight keywords exactly as you can with the 
original captured screen, and jump to the help file in the same way. Computer 
memory is the only limit to the number of data files and windows that may be 
opened this way.

The best way to learn about context sensitive help is to try using it with an 
application. For that, you will have to quit this tutorial, start an 
application that has a help file, and then re-enter the help system, capturing
your application screen and searching it. When you enter the help system from 
an application, the help file for that application automatically appears.

For these steps, see Finishing the Tutorial



Finishing the Tutorial
If from here you wish to try the context sensitive features of the HHELP Help 
System, you will have to quit, start an application and then restart help.

To QUIT help: type ALT+X

To RESTART help: open your application, then type ALT+?.

NOTE: As you try the context sensitive features, you can call up this file for
help by typing ALT+H, H, or selecting the Help menu and the How to Use choice 
from that menu.

If you wish to return to the start of the tutorial and examine the reference 
information, see below.

The buttons at the top of the help window - the text boxes containing the 
words Contents, Search, and the <<< >>> (called browse buttons) - are 
alternate ways of moving from topic to topic.

Selecting the Contents button will return you to the beginning of the 
tutorial. From here you can select topics from the reference list.

Selecting the Back button will take you back to your previous topic. In fact, 
repeatedly selecting the Back button will take you further and further back, 
until you are at the beginning of the help file.



Starting and Stopping the Help System
If the HHELP System has been installed via the TSR program HHLOAD it is always
available and can be started at any time EXCEPT when you are in Microsoft 
Windows. (A DOS session under Microsoft Windows is acceptable.)

You can start the Help System in two ways.

The first is by typing ALT+?. If you are running an application that has a 
help file, the help system will capture the screen and open the appropriate 
help file for you.

If the application has no help file, or if you are not running an application,
a window appears listing all the available help files. You may choose one by 
selecting it with the mouse, or by using the keyboard (arrow keys followed by 
enter. The current screen is captured and the help file you chose is opened.

The second way to start is by typing a command at the DOS prompt.

To QUIT the Help System, you simply type ALT+X. You may also close all the 
windows by clicking on the close button in the upper left hand corner of the 
window border. Closing all windows shuts the help system. 

See Windows for more information on manipulating windows.



Windows
All help files, data files, and the captured screen appear in windows in the 
help system. The windows are the boxes with double-lined borders. These 
instructions explain how to manipulate windows.

Changing the size of a window
Closing A Window
Moving a window
Scrolling through windows 
Switching between windows

See also special commands for the secondary window menu



Moving around the Help File
Apart from selecting jumps and pop-ups, there are several convenient ways to 
move around the help system.

See:

Backtracking
Browsing
Contents option
Scrolling 
Searching



Backtracking
To go backwards through a series of jumps you have just made, select the Back 
button on the help window. This will jump you backwards to where you have just
been. Repeated selections of back will move you further and further back, up 
to limit of 100 jumps.



Browsing
To look at a series of adjacent topics, select the <<< or >>> buttons. This 
will take you through a series of adjacent topics. This may be useful, but 
there is not necessarily any logic to the arrangement. Also, moving through a 
help file this way will not necessarily show all of the topics.



Contents option
To go back to the first topic of a help file (the contents topic), select the 
Contents button.
You can scroll up and down to display long topics in windows by selecting the 
up and down scroll arrows on the help window.



Searching
To find a help topic by entering a keyword, select the Search button in the 
help window.

This brings up the search index window. It has a list of keywords that you can
scroll through using scroll arrows. There is also a box for quickly entering 
keywords you wish to search for. When you see the desired keyword in the list,
select it,  and then select from among the list of help topics that is 
displayed in the bottom box of the window. The topic you have selected is then
displayed in the help window.



Starting HHELP at the DOS Prompt
From the DOS prompt type:

HHELP
Brings up the window containing all the help files on the system as defined in
the HHELP.INI file. If the environment variable HHELP= has been set (for 
example SET HHELP=FIRSTAID), then the named .HLP file will start automatically
without using the HHELP.INI file.

HHELP /1
Brings up the window containing all the help files on the system as defined in
the HHELP.INI file. Puts the screen into 50-line mode. The above note on the 
environment applies here also.

HHELP C:\HHELP\<ANY HELP FILE>.HLP
Starts the help system running with the help file you have selected. This 
option skips reading the HHELP.INI file. You can press F1 while in HHELP to 
pop up the menu selections from the HHELP.INI file later.

HHELP C:\HHELP\<ANY HELP FILE>.HLP <ANY DATA FILE>
Starts the help system running with the help file you have selected and also 
opens the data file you have specified in a window. The opened data file may 
be searched for keywords.



Using the Help System with Programs and Data Files
The HHELP help system is context sensitive. You can move the cursor across the
captured screen window and data file windows (when they are active) to 
highlight words and then jump straight from those words to the correct spot in
the help file.

When you come across a highlighted word:

press the RIGHT mouse button for the search index of keywords
press the LEFT mouse button to go directly to the first relevant topic 
containing information about those words.

For more information see:

Context Sensitivity 
and
Starting HHELP at the DOS Prompt 



Graphics in the Help System
One limitation of the HHELP help system is that it works only in DOS text 
mode, which means it cannot show graphics. Note that some DOS applications run
in a graphics mode. These screens will not be captured when the help system is
invoked. Some applications, such as AutoCAD, can run in both text and graphics
mode. To properly capture the screens of these applications when starting the 
help system, make sure the application is in text mode.

For graphics display, there is an additional feature. Some text within the 
help file appears in magenta with a black background (see below). Selecting 
this text will load a graphic viewer to display the graphic image with the 
same name as the magenta text following the special character to identify the 
graphic viewer ($ here). 

Your graphics images can contain information that demonstrates or supports the
information in your help file.

Try this example: $IMAGE

The HVIEW.EXE program supplied as a demonstration graphics viewer program will
display the IMAGE.GIF file. Remember that this will only work if you have 
loaded the two TSR programs AVLOAD.EXE and HHLOAD.EXE before using HHELP.

Note that if you use a graphic viewer to view a graphic from a HHELP help 
file, you cannot start up the help system from within the graphic viewer 
itself.



Available Help Files
Dont forget Windows applications have their own help systems, and that all 
HHELP help files can also be run from within Windows if you wish. HHELP help 
files are currently available to HHELP registered users for:

MS DOS
Banyan Vines Networking
AutoCad

As more help files become available, they will be made available distributed 
to registered HHELP users via bulletin boards and network systems, and this 
list will be updated.



File Menu
The File menu can be reached by typing ALT+F or by selecting it with the 
mouse, then selecting one of the sub-options.

Open (press O) brings up a dialog box from which the user can select 
additional help files to open.

Print (press P) sends the current topic to your printer.

Exit (press X) closes the help file. This does not quit the help system, 
however, unless all of the other windows are closed.



Bookmark
The Bookmark menu can be typing ALT+B or by selecting with the mouse. The 
choices presented in the window that appears may also be selected by key (the 
highlighted letter in the menu option you want) or mouse.

Bookmarks mark topics in the Help file that you access frequently and wish to 
mark for quick reference.

Goto sends you to the selected bookmark from the list.

Add creates a bookmark for the current topic

Delete removes the selected bookmark

Cancel closes the bookmark window

To change the text in a bookmark, place the mouse cursor over the topic name 
at the top of the window and press the left button. The cursor will be in the 
first column. Use the INSERT and DELETE keys or other keys to edit the text. 
Then use the Add button to add the book mark.



Help
The file menu can be reached by typing ALT+H or by selecting with the mouse. 
The choices may be selected by mouse or by typing the key that corresponds to 
the highlighted letter in the menu option.

How to Use (type H) calls up this help file

About gives (type A) information on the help file



Capture window menus
The capture window (and any data file windows you may open) have three menu 
commands.

File and Help are the same as the menu options in the help file window.

The search menu allows you to search for a particular text string or to jump 
to a line number.

Note also the capture window does not have a scroll bar on the side, but near 
the top.




